


PowerAlbum Help Contents

Choose the topic for which you want information:

Overview introduces PowerAlbum and briefly describes how you can use it.

Parts of the screen explains all the elements of the PowerAlbum screen.

How to gives you step-by-step instructions for PowerAlbum's most common 
functions.

Menu commands describes all menu commands.

Keyboard and mouse provides instructions on selecting commands with either the keyboard 
or mouse. It also lists keyboard equivalents for various functions of 
PowerAlbum.

Messages lists possible error messages and tells you what you can try to do if you
get them.

Glossary defines special terms as used in PowerAlbum.

To learn how to use Help, press F1.





Keyboard and mouse

Keyboard

Selecting commands using keys 

Mouse

Selecting commands using the mouse 

See also

Overview 
How to 



Selecting commands using keys

To select a menu command using keys:

1. Press ALT or F10 to activate the menu bar.

2. Select a menu by pressing the underlined letter in the menu name.

3. Select a command by pressing its underlined letter.

Some commands have keyboard shortcuts. 

To select this Use this
File | Save SHIFT+F12
File | Save As F12
File | Print Catalog CTRL+P
File | Exit ALT+F4
Edit | Cut CTRL+X
Edit | Copy Picture CTRL+C
Edit | Paste CTRL+V
Edit | Find CTRL+F
Picture | Add to Album CTRL+A
Picture | Display CTRL+D
Picture | Play Sound CTRL+S
See also

Keyboard and mouse 



Selecting commands using the mouse

To select a command using the mouse:

1. Point to a menu name.

2. Click the left mouse button. 

3. Point to a command name.

4. Click the left mouse button. 

See also

Keyboard and mouse 





Menu commands

File menu
New 
Open 
Merge Albums 
Save 
Save As 
Print Catalog 
Printer Setup 
Auto Album Scan
Exit 

Edit menu
Cut 
Copy Picture 
Copy Path
Paste 
Find 

Picture menu
Add to Album 
Remove from Category 
Delete File from Disk 
Display 
Assign Sounds to Pictures
Assign Pictures to Sounds
Play Sound
Paths and Information
Export

Category menu
Add 
Modify 
Merge 
Delete 

Options Menu
Change Style
Preferences



New command

Use the New command on the File menu to create new albums. Reasons for using multiple albums 
include:

More albums provide more ways to categorize your pictures, sound and video files.
Smaller albums are easier and faster to use.
If two or more people use the same computer, they can have separate albums.

When you use the New command, PowerAlbum automatically closes the open album. PowerAlbum will 
prompt you if there are unsaved changes before closing it. Choose Yes to save the changes or No to 
discard them. 

New albums are blank and contain no categories. A new album is opened to the Contents page. You must
add at least one category before you can add any files.

See also

Creating a new album 
Adding categories 
Adding files 
Saving an album 
Menu commands 



Open command

Use the Open command on the File menu to open an existing album. Opening another album 
automatically closes the active album. PowerAlbum will prompt you if there are unsaved changes before 
closing the active album. Choose Yes to save the changes or No to discard them. 

See also

Opening an album 
Menu commands 



Merge Albums command

Use the Merge Albums command on the File menu to copy the contents (pictures and categories) of a 
closed album into the open album. 

See also

Saving an album 
Merging albums 
Menu commands 



Save command

Use the Save command on the File menu to save changes (such as added pictures or categories, 
merged categories, new picture descriptions, and so on) to the open album. 

If the album you are saving has not been saved before, the Save As dialog box appears. Use it to give the
album a name and specify its location.

Keyboard shortcut

SHIFT+F12

See also

Saving an album 
Menu commands 



Save As command

Use the Save As command on the File menu to save a new album for the first time, or to save an existing 
album with a new name or in a new location.

When you are using the Save As command, you do not have to specify a file extension. PowerAlbum 
automatically adds .ALB. If you try to add a different extension, PowerAlbum will change it. 

Once you save an album for the first time, you can use the Save command to save any changes 
thereafter.

Keyboard shortcut

F12

See also

Saving an album 
Menu commands 



Print Catalog command

Use the Print Catalog command on the File menu to print a catalog of pictures, sounds, and video clips 
from the open album. A catalog resembles your album on the screen, except that one catalog page can 
contain up to four screen pages. Below each picture in the catalog appears its filename. 

You print a catalog by categories, including and excluding those of your choice. You cannot print 
individual pictures. 

You have the option of including the table of contents for the album. It lists all the categories and the 
pictures in each category. It can also include the complete path name for each picture and/or sound.

When printing a catalog, you choose between your printer's resolution and Draft mode. Printer resolution 
provides sharper images, but can take more time to print than Draft mode. Before you can use the Print 
Catalog command, you must have a printer driver installed with the Windows Control Panel.

Keyboard shortcut

CTRL+P

See also

Printing a catalog 
Printer Setup command 
Menu commands 



Printer Setup command

Use the Printer Setup command on the File menu to choose between installed printers and to make 
changes to printer options. To install another printer driver, use the Windows Control Panel.

See also

Printing a catalog 
Menu commands 



Exit command

Choose Exit from the File menu to close PowerAlbum and return to the Windows Program Manager or 
other active application. PowerAlbum will prompt you if there are unsaved changes before closing the 
active album. Choose Yes to save the changes or No to discard them. 

You can also use the Close command on the Control menu to exit PowerAlbum.

Keyboard shortcut

ALT+F4

See also

Parts of the screen for information on the Control menu
Menu commands 



Cut command

Use the Cut command on the Edit menu to move the selected picture to the Clipboard. You can then use 
the Paste command to move the picture to a different page in the same category, to a different category, 
or to place it in another application. 

If you want to leave the picture in its place on the page, use the Copy Picture command instead.

Keyboard shortcut

CTRL+X

See also

Paste command 
Copy Picture command 
Moving, copying, and rearranging pictures 
Menu commands 



Copy Picture command

Pictures

Use the Copy Picture command on the Edit menu to copy the selected picture to the Clipboard. You
can then use the Paste command to place the picture in another category or in another application. 

If you want to move the picture to another page in the same category, use the Cut command 
instead.

Video Clips

Copying a video clip copies only the currently displayed frame to the Clipboard.

Sounds

You cannot copy a sound.

Keyboard shortcut
CTRL+C

See also

Paste command 
Cut command 
Moving, copying, and rearranging pictures 
Placing pictures or a video clip frame in other applications 
Menu commands 



Paste command

Use the Paste command on the Edit menu to insert the picture or video clip frame on the Clipboard into 
another application. If you are moving the picture or video clip frame within PowerAlbum, use Paste to 
insert it into a selected picture frame or, if no frame is selected, into the first empty frame on a page.

Keyboard shortcut

CTRL+V

See also

Copy Picture command 
Cut command 
Moving, copying, and rearranging pictures 
Placing pictures or a video clip frame in other applications 
Menu commands 



Find command

Use the Find command on the Edit menu to search for pictures, sounds, or video files in an album. 
PowerAlbum finds pictures by matching text you enter in the Find dialog box to a picture's description or 
filename. You can enter entire words or only a few characters. 

Search for pictures by file type by entering a period followed by the desired file extension. For example, 
enter ".TIF" to search for TIFF pictures. 

Choose Find Next and PowerAlbum selects the next picture whose filename or description matches the 
text you entered. The Find dialog box moves so that you can see the picture. Continue to use Find Next 
until you have the picture you want. 

Choose Find All and PowerAlbum copies all of the pictures it finds into a temporary category called 
Found. It automatically opens the album to the first page of this new category. If you want to make this 
category permanent, you must rename it to something other than "Found."

Keyboard shortcut

CTRL+F

See also

Searching for pictures 
Renaming categories 
Adding and editing a picture's description 
Menu commands 



Add to Album command

Use the Add to Album command on the Picture menu to add pictures, sounds, and video clips on your 
disk to the open album. You can add more than one file at a time, but adding a great number of files at 
once could be slow. When adding files, you can either select an existing category in which you want to 
insert them or create a new category for them.

If you want to add pictures of the same file type that are stored in different subdirectories, use the Include 
All Subdirectories option. For example, if you want to add all your TIFF pictures stored on the C drive, 
choose C:\ from the list of Directories, choose TIFF from the list of file types, and check the Include All 
Subdirectories option. 

Note: An album must have at least one category before you can use the Add to Album command.

Keyboard shortcut

CTRL+A

See also

Adding files 
Adding categories 
Menu commands 



Remove from Category command

Use the Remove from Category command on the Picture menu to delete the selected thumbnail picture 
from a category or, if it appears in multiple categories, from the entire album. This command does not 
affect the actual file on your disk.

If you want to replace the picture, you must either add it to the album again or copy it from another 
category.

See also

Removing pictures from a category 
Adding files 
Moving, copying, and rearranging pictures 
Deleting pictures from your disk 
Menu commands 



Delete File from Disk command

Use the Delete File from Disk command on the Picture menu to delete the selected file from your disk. Be
careful; you cannot undo this command. 

If you simply want to remove the thumbnail from the album, but you don't want to delete the file, use the 
Remove from Category command.

See also

Deleting pictures from your disk 
Remove from Category command 



Display command

Pictures

Use the Display command on the Picture menu to see the selected picture in all its detail. Because 
picture sizes can vary, the selected picture may not fit within the Display window. If this occurs, you 
can either use the scroll bars to see the hidden portions of the picture or resize the window. 

Click anywhere in the Display window to close it.

Video Clips

Use the Display command to playback the clip. See Playing Video for more information.

Keyboard shortcut

CTRL+D

See also

Displaying a picture in full size 
Menu commands 



Add category command

Use the Add command on the Category menu to add new categories to the open album. You can add 
more than one category at a time. 

New categories are empty. To add pictures to them, use the Add to Album command or copy pictures from
other categories.

See also

Adding categories 
Add to Album command 
Moving, copying, and rearranging pictures 
Menu commands 



Rename category command

Use the Rename command on the Category menu to rename an existing category. When using this 
command, make sure you are on a page of the category which you want to rename. 

See also

Renaming categories 
Menu commands 



Merge categories command

Use the Merge command on the Category menu to merge two existing categories. PowerAlbum copies all
the pictures from one category (the Merge From category) into another(the Merge To category). The 
Merge From category remains unchanged.

You may want to merge two categories if you want to delete one category but keep its pictures in the 
album.

See also

Merging categories 
Deleting categories 
Menu commands 



Delete category command

Use the Delete command on the Category menu to remove a category and its pictures from the open 
album. Deleting a category does not affect the actual graphic files; they remain in their original directories 
on your disk.

If you want to delete a category, but keep its pictures in the album, merge the category with another or 
copy the pictures to another category.

See also

Deleting categories 
Merging categories 
Moving, copying, and rearranging pictures 
Menu commands 



Scanning Albums

Use this feature to display every image and play each sound or video clip in an album onscreen, or to 
display certain groups of files in an album.

To scan an album:

1. Choose File | Auto Album Scan.

2. Specify how long you want each image to be displayed (or how long a sound or video clip is 
played).

3. Select which types of files (pictures, sound and/or video) to scan.

4. Choose whether you want PowerAlbum to prompt you before it redisplays an album from the 
beginning.

5. Click on OK to start scanning the album.

PowerAlbum starts scanning at the currently selected image, which may not be the first image in 
the album.

6. While scanning the album, click the mouse at any time to stop the process.

See also

Playing Sound
Playing Video
Display a picture in full size



Copy Path Command

This command copies the full path and file name of the selected file to the Clipboard. You can then paste 
that text into another application.

See also

Copy Picture Command



Assigning Sounds to Pictures

If you like, you can add sounds (WAV files) to your picture thumbnails and then play those sounds in 
PowerAlbum. For example, you might add the sound of squealing tires to a picture of a sports car. Once 
you have assigned a sound to a picture, a speaker symbol appears in the thumbnail.

To assign a sound to a picture:

1. Choose Picture | Assign sounds to pictures.

2. Select an album category from the drop-down list to display a list of pictures in that category.

3. Select a picture from the list by clicking on it.

4. Select a sound from the second list by clicking on it.

The sound is now assigned to the selected picture. You can play the sound by clicking on the Play 
Sound button.

5. Repeat steps 2 through 4 as many times as you like.

6. When you are finished, click on Done.

See also

Assigning Pictures to Sounds



Assigning Pictures to Sounds

When you add a sound (a WAV file) to an album, the name of the file and a speaker symbol appear in the 
thumbnail. You can add a picture to the thumbnail to make the sound clip easier to identify.

To assign a picture to a sound:

1. Choose Picture | Assign pictures to sounds.

2. Select an album category from the drop-down list to display a list of sounds in that category.

You can play the sound by clicking on the Play Sound button.

3. Select a sound from the list by clicking on it.

4. Select a picture from the second list by clicking on it.

The picture is now assigned to the selected sound.

5. Repeat steps 2 through 4 as many times as you like.

6. When you are finished, click on Done.

See also

Assigning Sounds to Pictures



Playing Sounds

To play a sound in PowerAlbum:

1. Click on the thumbnail for the sound that you want to play.

2. Choose Picture | Play Sound.

Note:    If you do not have a sound card, you will not be able to play sounds with PowerAlbum.



Paths and Information

You can check the name and location of pictures, sound and video clips with the Paths and Information 
command. This may be useful if you have assigned sounds to pictures or vice versa and the name of the 
assigned file does not automatically display in the PowerAlbum window itself, or if you have clip art stored
on a drive other than your hard drive.

To display path information:

1. Select the thumbnail for the file you want to identify.

2. Select Picture | Path and Information.

3. When youre done looking at the information, click on OK.



Converting Pictures to Other Formats

In addition to simply cataloging your images, PowerAlbum can also convert them to other formats.

To save a picture in another format:

1. Click on the thumbnail of the image you want to export.

You can't export sound or video files.

2. Choose Export... from the Picture menu. 

3. From the List of File Types, select the format in which you want to save the picture.

4. If necessary, type a new name and file extension for the new picture.

5. Click on OK.

The new graphic file is created but not automatically added to an album. To add the picture to an 
album, see Adding Files.

Note:    You can only convert bitmapped graphics to other bitmapped formats and vector images to 
other vector formats. For example, you can convert a .BMP file to a .PCX file, but not to a .WMF 
file.



Album Styles

Use the Change Style command to choose how many images appear on each page of the currently open 
album and, consequently, how large each individual image will be. For example, for an album of very 
detailed clip art, you may want to display fewer pictures on a page, so each thumbnail is larger and more 
detail can be seen.

To change an albums style:

1. Choose Options | Change Style.

2. Select one of the following. An example displays in the dialog box for each album style.

Small - 12 thumbnails per page, two pages displayed onscreen, with category tabs at the side of 
the album

Medium - 6 thumbnails per page, two pages displayed onscreen, with category tabs at the side of 
the album

Large - 4 thumbnails per page, one page displayed onscreen, with category tabs at the bottom of 
the album

3. Click on OK to confirm your choice.

For a very large album, it may take some time to change the display to a new style.

See also

Display Preferences



Display Preferences

If you have the appropriate hardware, you can display PowerAlbum thumbnails in up to 16,777,216 
colors. Remember, using more colors will increase the size of albums and may slow down the 
performance of PowerAlbum.

To change the display of thumbnail colors for the open album:

1. Choose Options | Preferences.

2. Select 16; 256; 65,536; or 16,777,216 colors for thumbnail display. If your system doesnt support an
option, it is grayed out.

Note:    Any changes made will not apply to vector graphics, such as WMF files.

3. Choose a thumbnail palette, which determines which particular colors are used for display in 
PowerAlbum.

Default gives you the fastest performance on your system, while Optimized gives you slower 
performance but the best color choices for your thumbnail images.

4. Click on OK to confirm your choice.

Thumbnails for all new pictures added will be displayed with the new color options. Existing 
thumbnails will not change unless you delete them and add the pictures to the album again.

See also

Album Styles





How to use PowerAlbum

Pictures
Adding 
Deleting from your disk 
Descriptions (adding and editing) 
Displaying in full size 
Moving, copying, rearranging 
Placing in other applications 
Removing from a category 
Searching (finding) 
Converting Pictures to Other Formats

Sound and Video
Playing Sounds
Playing Video
Assigning Sounds to Pictures
Assigning Pictures to Sound

Categories
Adding 
Deleting 
Merging 
Renaming 
Scanning Albums
Album Styles
Display Preferences

Albums
Creating a new album 
Merging 
Navigating through 
Opening 
Saving 

Printing a catalog 



Adding and editing a picture's descriptions

Pictures you installed with the setup program probably have descriptions; you can change these or add to
them if you like. Pictures that you add to PowerAlbum later will not have descriptions, but you can add 
your own. 

Descriptions can be useful because you can use the Find command to search for any word, or part of a 
word, in a description. When entering descriptions, it is a good idea to use a variety of descriptive words, 
including some general concepts. For example, you might describe a picture of a sports car as "car, 
transportation, speed."

To add or edit a picture's description:

1. Select the picture.

2. If the description text box does not contain a blinking line cursor, click the box.

3. Type the new word or phrase at the cursor. Separate words by spaces and/or commas. You can 
enter up to 64 characters. 

4. After you have made all your changes or additions, choose File | Save Album to save the 
descriptions.

See also

Searching for pictures 
Saving an album 
How to 



Adding categories

To add a new category:

1. Choose Category | Add.

2. Type a name for the new category in the Add Category dialog box.

3. Choose OK to add the category and close the dialog box, or choose Add Another to leave the dialog
box open so you can add another category.

New categories are empty. To add pictures to them, you can copy pictures from other categories or use 
the Add Picture command.

You can also add a new category when you are adding pictures to an album or when you are using the 
Find All function.

See also

Add category command 
Adding files 
Moving, copying, and rearranging pictures 
Searching for pictures 
How to 



Adding files

You can add one or more pictures, sounds, or video clips to an album in one operation. When adding 
files, you can either add them to an existing category or create a new category and add them to it. 

To add files to an album:

1. Choose Picture | Add To Album. The Add Picture dialog box appears. 

2. Choose the drive and directory where the files you want are located.'

3. If the drive is a CD, floppy disk or other removable media, type a description for that volume.

Once you type a description, that volume will be available as a choice whenever you add pictures. 
For example, if you enter ANIMALS for a CD that contains wildlife files, you will be prompted to 
insert the ANIMALS CD whenever PowerAlbum needs to access those files.

4. Use the List Files of Type to see only files of a particular type (PCX, TIFF, and so on) or to see all 
the files in the current directory (*.*).

5. Select the file(s) you want to add. To select adjacent files, drag the pointer down the list. To select 
nonadjacent files, hold down the CTRL key as you select each file. To select every file in the list, 
choose Select All.

Note: Adding files takes time. If you try to add a large number of files at one time, it may take a 
considerable amount of time.

6. You can check Suppress Error Messages to prevent PowerAlbum from displaying error 
messages while adding files to the album.

Note: If you check this option, a message is displayed at the end of the process indicating how many 
files were selected and how many were added successfully.

7. Choose OK. The Select Category dialog box appears.

8. Select the category you want to receive the files or choose the Add Category button to create a new
category or choose to create catagories based on file type or directory names. If you choose Add 
Category, type the name of the new category and choose OK.

9. Choose OK. PowerAlbum adds the files to your album. When it's finished, it reports how many files 
were successfully added.

10. Choose OK once again.

See also

Add to Album command 
Adding categories 
How to 



Creating a new album

To create a new album:

Choose File | New. If you have not saved recent changes to the open album, PowerAlbum asks if 
you want to do so. Choose Yes to save the changes, or No to discard them.

The new album appears at once. It is untitled and contains no categories or pictures. Before you can add 
pictures, you must first add at least one category. 

See also

New command 
Adding files 
Adding categories 
Saving an album 
How to 



Deleting categories

Deleting a category removes both the category and the pictures displayed in it from your album. Deleting 
a category does not affect the graphic files themselves; they remain in their original directories.

If you want to delete a category but keep the pictures it contains, copy or merge them into another 
category first. 

To delete a category:

1. If you are on the Contents page, select the name of the category you want to delete. If not, make 
sure you are on a page in the category you want to delete.

2. Choose Category | Delete.

3. Choose OK to delete the category.

See also

Delete category command 
Moving, copying, and rearranging pictures 
Merging categories 
How to 



Deleting pictures from your disk

You can delete a file from your disk without leaving PowerAlbum. Be careful, as this is a permanent 
deletion.

To delete a file from your disk:

1. Select the picture you want to delete and choose Picture | Delete File From Disk.

2. Choose OK to delete the file.

3. Choose File | Save to save the change to your album.

If you do not save the album, the deleted picture will appear the next time you use the album, although 
the file is no longer on your disk.

See also

Delete File from Disk command 
Saving an album 
How to 



Displaying a picture in full size

The pictures in your albums are reduced to thumbnails to fit onto the album pages.

To see a picture displayed in its actual size:

Select it and choose Picture | Display. Click anywhere in the display window to close it.

If a picture is too large to fit the display window, scroll bars appear. To see the entire picture, either use 
the scroll bars or enlarge the size of the display window. 

When a video clip is selected, use the Display command to playback the clip.    See Playing Video for 
more information.

See also

Display command 
Placing pictures or a video clip frame in other applications 
How to 



Merging albums

Merging albums copies the contents of a closed album into the currently open album. 

To merge albums:

1. Open the album that you want to receive the pictures.

2. Choose File | Merge Albums. 

3. Choose a drive, if necessary, and navigate through the Directories box to find the album you want.

4. Choose the album (.ALB file) that you want to copy from the File Name list box.

5. Choose OK.

See also

Merge Albums command 
Saving an album 
Merging categories 
How to 



Merging categories

Merging categories copies all the pictures from one category (the Merge From category) into another (the 
Merge To category). The original Merge From category remains unchanged.

1. Choose Category | Merge. The Merge Categories dialog box appears.

2. Choose the category from which you want to copy the pictures from the left-hand Merge From list. 
You can only choose one category.

3. Choose the category to which you want to copy the pictures from the right-hand Merge Into list.

4. Choose OK.

See also

Delete category command 
Deleting categories 
Merging albums 
How to 



Moving, copying, and rearranging pictures

To rearrange pictures on a page:

Select a picture and drag it to another frame. 

To move a picture to another page within the same category:

1. Select the picture and choose Edit | Cut.

2. Move to the new page and select the frame where you want the picture to appear.

3. Choose Edit | Paste. The picture already in that frame moves to the right.

To move a picture to another category:

Select the picture, hold down the SHIFT key and drag the picture over the tab of the category in 
which you want to place it. When the tab is highlighted, release the mouse button. The picture will appear 
in the first empty frame of that category.

You can also use the Cut and Paste commands in the same way as moving a picture from page 
to page within a category.

To copy a picture from one category to another:

Select the picture and drag it over the tab of the category to where you want to copy it. Release 
the mouse button when the tab is highlighted. You can copy a picture to as many different categories as 
you want.
See also

Removing pictures from a category 
Placing pictures or a video clip frame in other applications 
How to 



Navigating through an album
To move to the next page, click the arrow next to the page number of the right-hand page. To 

move to the previous page, click the arrow on the left-hand page.
To move to another category, click its tab.
Choose Contents to move to the Contents page.

See also

Searching for pictures 
How to 



Opening an album

When you open another album, PowerAlbum automatically closes the currently open album; you can 
have only one album open at a time.

To open an existing album:

1. Choose File | Open. If you have not saved your recent changes, PowerAlbum asks if you want to do
so. Choose Yes to save the changes or No to discard them. The Open Album File dialog box 
appears.

2. Choose the drive and directory, if necessary.

3. Select the desired album name.

4. Choose OK.

See also

Open command 
Creating a new album 
How to 



Placing pictures or a video clip frame in other applications

To copy a picture or a video clip frame into another application:

1. Find the desired picture or video clip and select it by clicking it. A heavy frame appears around the 
picture.

2. Choose Edit | Copy Picture to place a copy of the picture on the Clipboard. 

3. Minimize or exit PowerAlbum.

4. Switch to the document where you want to place the picture. This can be a document in any 
Windows application that lets you paste pictures from the Clipboard.

5. Find the location where you want to put the picture and choose Edit | Paste.

Note:    Copying a video clip only copies the currently displayed frame to the clipboard, that is the 
frame that will be inserted into the selected document.

See also

Searching for pictures 
Adding files 
Copy Picture command 
How to 



Removing pictures from a category

Removing a picture from a category deletes the thumbnail image of that picture. If the picture occurs in 
more than one category, you can choose to remove it from the entire album. This does not affect the 
actual graphic file on your disk. 

To remove a picture from a category:

1. Select the picture you want to remove and choose Picture | Remove From Category. 

2. Choose Category Only to remove the picture from the current category. If the picture appears in 
other categories, it remains in them. Choose Entire Album to remove every occurrence of the 
selected picture from the album.

If you want to restore the picture later, you will have to add it to the album or copy it from another 
category.

See also

Remove from Category command 
Adding files 
Moving, copying, and rearranging pictures 
Deleting pictures from your disk 
How to 



Renaming categories

You can either rename a category from the Contents page, or from a page in the category itself.

To rename a category from the Contents page, select it, then click the text box at the bottom of 
the window and type the new name.

To rename a category from one of its pages:

1. Select Category | Rename. 

2. Edit the name in the Category Name text box or type a new name over it.

3. Choose OK.

See also

Adding categories 
How to 



Saving an album

To save a new album, or to make a copy of the album with a different name:

1. Choose File | Save As. The Save Album File dialog box appears.

2. Type the name in the File name field. Choose a different drive and directory if you want.

3. Choose OK. The name of the album appears in the Title bar at the top of the window.

Once you have used Save As to give a new album a name, you can choose File | Save to save other 
changes, such as added pictures, rearranged pages, or new descriptions.

See also

Save As command 
Creating a new album 
How to 



Searching for pictures

Use Find to search for pictures by their descriptions, file names, or file types. 

To use Find:

1. Make sure you are not on the Contents page and choose Edit | Find.

2. Type the file name, file name extension, or the word you want to search for in the Find What text 
box. You can enter a whole word, or part of a word. For example, "vine" will find any filenames and 
descriptions that contain those four characters, such as "vineyard" or "ravine."

If you enter two or more words separated by a space, Find will search for all the pictures whose 
descriptions contain any of these words. Entering "birthday party" will find all pictures with "birthday"
in their descriptions, as well as all the pictures with "party" in their descriptions.

3. Choose Find Next to see the first picture found. Continue to choose Find Next until you locate the 
picture that you want.

Or, choose Find All to copy all of the found pictures into a temporary category called Found. At the 
end of the search, PowerAlbum opens the album to the first page of this category. 

Hint: Once you have a Found category, you can make it permanent by renaming it, thereby creating a 
new category.

See also

Find command 
Adding and editing a picture's description 
Renaming categories 
How to 



Printing a catalog

To print a catalog:

1. Choose File | Print Catalog.

2. Select the categories you want to appear in your catalog from the categories list box. 

To select adjacent categories, drag the pointer down the list. To select nonadjacent categories, 
press CTRL and hold it down as you select each category. To select all the categories displayed in 
the categories list box, choose the Select All button. Choose Table of Contents if you want to print 
the table of contents for your entire album. 

3. If you are printing the table of contents, you can suppress the printing of each picture and/or 
sound's complete path name by selecting the check box below the categories list box. 

4. Choose the resolution at which you want to print your catalog: Printer resolution or Draft. Printer 
resolution produces clearer images but takes more time than printing in Draft.

5. Choose OK.

See also

Print Catalog command 
How to 



Playing Video

Any video clips (AVI files) are marked with film symbols in their thumbnails.

To play a video clip in PowerAlbum:

1. Click on the thumbnail for the video clip that you want to play.

2. Choose Picture | Display

The video clip immediately begins playing. The slider at the bottom of the video window displays the
progress of the playback.

3. Click on the stop button to pause the playback.

If you click on the stop button, it becomes a play button. Click on it again to resume playing or to 
replay the clip.

4. Click on the menu button to display a list of video options.

View - Choose Half, Normal or Double.

Volume - Use the slider bar to increase or decrease the volume.

Speed - Use the slider bar to speed up or slow down the playback.

Copy - Copies the current frame to the Clipboard.

Configure - Choose to play the video in a window or full screen, to zoom in on the video, and to 
skip frames if necessary to keep the video in sync with any sound. Click the Default button to use 
the current options for all video clips. Click on OK when finished.

Command - See your video driver documentation for additional command you can use with video 
clips. Type the command and click on Send.

5. If youre playing the video full screen, you can click the mouse at any time to stop the playback and 
return to the video window.

6. Double-click the top left corner of the video window to return to PowerAlbum.





Parts of the screen

Title bar displays the application name, the name of the open album file, the 
Minimize button, and Control menu box.

Menu bar lists the PowerAlbum menus.

Picture album displays the pictures the album contains. 

Description and Filename display this information for the selected picture. 



Title bar

The top line of the PowerAlbum screen is the title bar. It displays

the name of the application (PowerAlbum)
the name of the current album file

It also contains the following mouse buttons:

the Control menu box, which you can click to display the Control menu or double-click to put 
away the application

a Minimize, which lets you return to Windows without losing your place in the application
See also

Parts of the screen 



Menu bar

The menu bar appears directly below the title bar, listing the PowerAlbum menus: File, Edit, Picture, 
Category, Options, and Help. Each menu contains a list of related commands.

To open a menu and select a command, do one of the following:

Click the menu name, then click the desired command.
Press ALT or F10 to activate the menu bar. Then select a menu by pressing the underlined letter 

in its name. With the menu open, select the command by pressing its underlined letter. For example, to 
open the File menu and select Exit, press ALT+F+X.
See also

Parts of the screen 



Picture album

The picture album is a graphic representation of a PowerAlbum file that looks like a real photo album. The
album contains reduced thumbnail images of your graphic files displayed in frames on pages, twelve to a 
page. The pictures are grouped into subject categories separated by tabs, as pictures in a real photo 
album often are.

To turn a page, click the arrow at the bottom of the page in the direction you want to go, as you 
would with a real book. Click the right-hand arrow to proceed to the next page, click the left-hand arrow to 
move back to the previous page.

To jump to another category, click its tab. The Contents tab moves you to the table of contents 
that lists all the categories in your album. If there are more categories than tabs, a More tab appears as 
the last tab. Click it to display the remaining category tabs.

To select a picture, click it. A heavy frame appears around the image. Note that a picture remains 
selected until you select another, even if you are not on that page.
See also

Parts of the screen 



Description and Filename text boxes

These two text boxes appear at the bottom of the PowerAlbum screen. When you select a picture, its 
description and filename appear in the respective text box. 

If your PowerAlbum package includes pictures that you installed with the PowerAlbum setup program, 
they probably have descriptions. Pictures of your own that you add to PowerAlbum will not have 
descriptions. You can change a picture's description or add a description to a picture at any time. 

You can search for pictures by searching for words, or parts of words, in a description or filename. 

See also

Adding and editing a picture's description 
Searching for pictures 
Parts of the screen 





Glossary

Point to the glossary term you want defined and hold down the mouse button.

album 
catalog 
category 
Clipboard 
Control menu box 
description 
double-click 
drag 
file type 
frame 
menu bar 
minimize 
path 
resolution 
thumbnail 
title bar 



album

An album is a collection of reduced or, thumbnail, images of files on your disk. It is the type of file created 
and used by PowerAlbum. An album has the file extension .ALB. 



catalog
A catalog is a printed record of the contained in an album. Use the Print Catalog command on the File 
menu to produce one.



category
A category is a division of pictures, usually defined by subject, such as Sports or Religion. Categories are 
separated by tabs. You may place a single picture in more than one category, if it seems appropriate. 
However, you can only place one copy of a picture in any category.



Clipboard
The Clipboard is a part of memory used to store information (text or pictures) temporarily. You can use it 
to move or copy items from one page or category to another in the same file, between files, or even 
between Windows applications. You cannot use it to paste pictures from other applications into 
PowerAlbum. 



Control menu box
The Control-menu box is the boxed minus sign in the upper left corner of the PowerAlbum screen. When 
you click this box once, the Control menu appears. If you double-click it, you exit the program.



description
In PowerAlbum, each thumbnail can have a brief description. You can use the Find command to search 
for words or characters included in a description. When you select a picture, its description appears in the
Description text box at the bottom of the PowerAlbum screen.



double-click
To press and release a mouse button quickly two times.



drag
To move or resize an object by pressing and holding down the mouse button as you move the mouse to 
the desired location.



file type
A file's type indicates how it stores information. In PowerAlbum, you can use files of the following types: 
AVI, BMP, CGM, DRW, EPI, GIF, JPG, PCD, PCX, TIFF, WAV, WPG, and WMF.



frame
In PowerAlbum, pictures are displayed in frames, up to twelve to a page. When you select a picture, the 
frame changes to a heavy line. You cannot select an empty frame. 



menu bar
The menu bar appears directly below the title bar near the top of the PowerAlbum screen. It contains the 
following menus: File, Edit, Picture, Category, Options, and Help. Each menu contains a list of related 
commands.



minimize
You can leave an application but keep it in memory by reducing it to its icon. This is called minimizing. You
can minimize the PowerAlbum window by clicking the downward-pointing triangle at the right edge of the 
title bar.



path
A path indicates the location of a file by specifying the drive, directory, and filename. For example, the 
complete path for the graphic file BONES.TIF might be C:\ART\MEDICAL\BONES.TIF. PowerAlbum 
stores a graphic file's path in an album file (.ALB). It does not store or encapsulate the actual graphic file 
in the .ALB file.



resolution
Resolution is the number of dots used to create an image on a screen or printer. The greater the 
resolution, the sharper the picture. 



thumbnail
A thumbnail is a reduced image of a picture, sound, or video file. Each thumbnail displayed in an album 
points to the graphic file on your disk.



title bar
The title bar appears at the very top of the PowerAlbum screen. It displays the application name and the 
open album name. It also contains the Control menu box and the Minimize button.





Overview

PowerAlbum is an innovative way to organize pictures, sounds, and video clips and select pictures for any
Windows program that can read a graphic file from the Clipboard. PowerAlbum makes it easy to locate 
and select files because you can

See reduced images (called thumbnails) of the actual pictures instead of a list of file names
Organize your files into subject categories any way you please, even across drives and 

directories
Search for pictures, sounds, and video clips by file name, file type, or key word

PowerAlbum looks and feels like an online photo album. An album contains reduced thumbnail images of 
your graphic files. They are grouped into subject categories separated by tabs, as pictures in a real photo 
album often are. You can flip through the pages of an album or jump directly to another category.

Once you find a picture you want to use in a document, copy it to the Clipboard. Then minimize or close 
PowerAlbum, activate the application that contains your document, find the location where you want the 
picture to appear, and paste it into place. 

See Also

Parts of the screen 
How to 





Open Album File dialog box

Use this dialog box to open an existing album. 

File Name
Type the name of the file you want to open or select it from the list. Only the files in the current directory
are displayed. Use the Directories option to change the directory.

List Files of Type
.ALB is the only type listed in this drop-down list. However, if the File Name box contains *.*, instead of 
*.alb, you will see a mixture of files in the file list. You can only open .ALB files with this command. 

Directories
The complete path of the current directory is displayed. If the file you want to open is not in this 
directory, navigate the Directories list box to open the desired directory. The directories listed reflect the 
current drive. If you need to change drives, use the Drives option. 

Drives
This option lists the current drive. If the album you want to open is on another drive, select it from this 
drop-down list. 

See also

Open command 
Opening an album 



Merge Albums dialog box

Use this dialog box to select an album you want to merge into the currently open album. The album you 
select remains unchanged.

File Name
Type the name of the desired album file or select it from the list. Only the albums in the current directory
are displayed. Use the Directories option to change the directory.

List Files of Type
.ALB is the only type listed in this drop-down list. However, if the File Name box contains *.*, instead of 
*.alb, you will see a mixture of files in the file list. You can only merge .ALB files with this command. 

Directories
The complete path of the current directory is displayed. If the file you want to select is not in this 
directory, navigate the Directories list box to open the desired directory. The directories listed reflect the 
current drive. If you need to change drives, use the Drives option. 

Drives
This option lists the current drive. If the album you want to select is on another drive, select it from this 
drop-down list. 

See also

Merge Albums command 
Merging albums 



Save As dialog box

Use this dialog box to specify the name and location of a new album. You can also use it to save an 
existing album under a different name or location. 

File Name
Type the name you want to give the new file. You can use up to eight characters. PowerAlbum 
automatically adds the proper file extension, so you don't have to add one.

List Files of Type
You can only save files with the .ALB extension. If you try to enter a different extension, PowerAlbum 
will change it.

Directories
The complete path of the current directory is displayed. If you want to specify a different location for the 
new file, navigate the Directories list box. The directories listed reflect the current drive. If you need to 
change drives, use the Drives option. 

Drives
This option lists the current drive. If you want to save your album to another drive, choose it from this 
drop-down list.

See also

Save As command 
Saving an album 



Find Picture dialog box

Use this dialog box to search for pictures in the open album. 

Find What
Enter the text for which you want PowerAlbum to search. It will find pictures, sounds, and video files 
whose descriptions or filenames match the text you enter. You can enter words or parts of words. You 
can enter up to 256 characters, but a long character string may be impractical. If words are separated 
by a space, PowerAlbum will find pictures that match either word. To search for pictures by their file 
type, enter a period followed by the proper file extension. For example, enter ".TIF" to search for TIFF 
pictures. 

Find Next
Choose this button and PowerAlbum displays the first picture that matches the search text. The dialog 
box remains open so you can continue the search. Once you find the correct picture, choose Cancel.

Find All
Choose this button and PowerAlbum copies every picture it finds into a temporary category called 
Found. It automatically opens the album to the first page of this category. 

See also

Find command 
Searching for pictures 



Add Picture dialog box

Use this dialog box to add pictures, sounds, and video clips to the open album. 

File Name
Select the file(s) you want to add from this list. To select adjacent files, drag the pointer down the list. To
select nonadjacent files, hold down the CTRL key as you select files. Only the files in the current 
directory are displayed. Use the Directories option to change the directory. 

List Files of Type
Choose the type of file you want to add. You can add AVI, BMP, CGM, DRW, EPI, GIF, JPG, PCD, PCX,
TIFF, WAV, WPG, and WMF files. The list of files will display files of the type you select. To see all file 
types, choose All Types.

Directories
The complete path of the current directory is displayed. If the file you want to add is not in this directory, 
navigate the Directories list box to open the desired directory. If you need to change drives, use the 
Drives option. The directories listed reflect the current drive. 

Drives
This option lists the current drive. If the file you want to add is on another drive, select it from this drop-
down list. 

Include All Subdirectories
Choose this option to add all the files of the selected type that are located in any subdirectory of the 
current directory. For example, if the current directory is C:\ART and the List Files of Type option is set 
to WMF, selecting this option will add every WMF file located in any subdirectory within C:\ART. 

Select All
When you choose this button, PowerAlbum selects every file listed in the File Name list box. You can 
deselect files by holding down the CTRL key as you click them.

Volume Information
Label - The label of the current drive.

Description - If the files you want to add are on removable media (CD, floppy disk, etc.), enter a volume 
description. Once you type a description, it will be available as a choice whenever you add files. For 
example, if you enter ANIMALS for a CD that contains wildlife photographs, you will be prompted to 
insert the ANIMALS disk whenever PowerAlbum needs to access those files.

Suppress Error Messages
Check to prevent PowerAlbum from displaying error messages when adding files to an album. This may
be useful if you are adding a lot of files and do not want to stay at the computer during the process.

Note:    If you check this option and PowerAlbum has a problem adding a file, it will not be added. 
However, a message is displayed at the end of the process indicating how may files were selected 
and how many were added successfully.

See also

Add to Album command 
Adding files 



Remove Picture dialog box

Use this dialog box to remove the selected thumbnail from the current category or the entire album. 
Removing a picture does not affect the actual file on your disk. 

OK
This button appears if the picture appears only in the current category. Choose it to remove the picture.

Category Only
If the selected picture appears in more than one category, you can choose this button to remove it from 
the current category only. All other copies remain in place.

Entire Album
If the selected picture appears in more than one category and you want to remove every copy of the 
picture from the album, choose this button. 

See also

Remove from Category command 
Removing pictures from a category 



Delete Picture dialog box

Use this dialog box to permanently delete the selected picture, sound, or video file from your disk. You 
may want to make sure the correct picture is selected by checking the Filename area of the PowerAlbum 
window before you continue. This deletion is permanent. 

If you only want to remove the picture from your album and you do not want to delete the file, use the 
Remove from Category command. 

OK
Choose this button to delete the selected file from your disk. Be careful, because you cannot undo this 
command.

Cancel
Choose this button if you don't want to delete the selected file or if you are not sure you have the correct
file selected.

See also

Delete File from Disk command 
Deleting pictures from your disk 
Remove from Category command 



Add Category dialog box

Use this dialog box to add a category or categories to the open album. 

Category name
Enter the name for the new category. 

Add Another
Choose this button to add the entered category and clear the Category Name field so you can add 
another category. 

OK
When you have entered all the desired categories, choose this button.

See also

Add category command 
Adding categories 



Rename Category dialog box

Use this dialog box to change the name of the current category (that is, the category currently displayed).

Category Name
The current category name appears in this field. Replace it by typing a new name.

See also

Modify category command 
Renaming categories 



Merge Categories dialog box

Use this dialog box to choose two categories you want to merge into one.

Merge From
Select the category whose pictures you want to copy to another category. This category remains 
unchanged after the merge.

Merge Into
This is the category that will receive all the pictures from the Merge From category. Select the desired 
category.

See also

Merge categories command 
Merging categories 



Delete Category dialog box

Use this dialog box to confirm the deletion of the specified category. 

OK
Choose this button to delete the category and its pictures from the open album. If any of the pictures 
appear in other categories they will remain there. This does not affect the actual graphic files on your 
disk.

Cancel
Choose this button if you do not want to delete the category or if the incorrect category is specified.

See also

Delete category command 
Deleting categories 



Print Catalog dialog box

Use this dialog box to specify options for printing a catalog of pictures, sounds, and video clips from the 
open album. 

Categories list
The categories in the open album appear in the list box on the left-hand side of the dialog box. Choose 
those you want to include in your catalog. To select adjacent categories, drag the pointer down the list. 
To select non adjacent categories, hold down the CTRL key as you select them. Choose Table of 
Contents to print the list of categories and their pictures from the open album.

Show Path Names in Table of Contents
Select this option if you want the complete path name of each picture and/or sound in your album to be 
printed in the table of contents.

Resolution option
Select the desired resolution. Printer resolution uses the resolution of your printer. This can produce 
sharper images than Draft, but can take more time to print. 

Select All
Choose this button to select all the categories listed as well as the Table of Contents.

See also

Print Catalog command 
Printing a catalog 



Picture Not Found dialog box

The picture you selected points to a file on your disk that is not in its original location. The file may have 
been moved or deleted. You can use this dialog box to search for that file. 

Search
Choose this button to search every directory on this drive for the selected file. If PowerAlbum does not 
find the file, you can choose another drive to search. Note that if the selected drive is large, such as a 
network drive, this can take time.

Drives list
The current drive is indicated. To search another drive, select it from the drop-down list.

If PowerAlbum is unable to find the file, you may have to add it to your album again. 

See also

Adding files 



Select Category dialog box

Use this dialog box to choose a category or create a new category to which you want to add your files. 

Category
This lists displays all the categories in the current album. Select the category to which you want to add 
your files.

Add Category
Choose this button to add a new category. The new category will appear in the Category list.

Create Categories Based on File Type
PowerAlbum automatically creates categories according to file type and places the files in them. For 
example, PowerAlbum may create WMF, PCX, and WAV categories.

Create Categories Based on Directory Names
PowerAlbum automatically creates categories according to directory names and places files in them. 
For example, if you are adding files located in directories called MAPS, FLAGS, and SYMBOLS, those 
will become category names.

See also

Add to Album command 
Adding files 



Print Catalog Problem dialog box

Your printer is set to print in Landscape orientation. Choose Printer Setup to change the printing 
orientation to Portrait.



Duplicate Picture dialog box

The picture(s) you are trying to add already appears in the selected category. A picture can appear only 
once in each category, although you can add a copy to as many categories as you wish. 

OK to All
If you choose this button PowerAlbum will not display this message for every duplicate picture. Instead, 
it will add as many pictures as possible. At the end of the operation, a dialog box appears with the total 
number of pictures you selected and the number successfully imported. 

OK
If you are adding a single picture, this simply cancels the adding procedure, and you can start over. If 
you are adding multiple pictures, PowerAlbum will try to add the next picture. If it also appears in the 
selected category, this dialog box reappears. 

See also

Add to Album command 



Printer Setup dialog box

Use this dialog box to select one of the installed printers. If you don't see the printer you want to use, you 
must use the Windows Control Panel to add another printer.

Printer
Select the desired printer.

Setup
Choose this button to configure printing options for the selected printer.



Import Picture Problem dialog box

PowerAlbum is unable to import the specified picture. This indicates you may not have enough memory or
the picture file was created and saved in an unusual variation of a standard graphics format. 

OK to All
If you choose this button PowerAlbum will not display this message for every picture it cannot import. 
Instead, it will add as many pictures as possible. At the end of the operation, a dialog box appears with 
the total number of pictures you selected and the number successfully imported. Choose this option if 
you do not want to be present as PowerAlbum imports the pictures.

OK
If you are adding a single picture, this simply cancels the procedure and you can start over. If you are 
adding multiple pictures, PowerAlbum will try to add the next picture. If it cannot be imported, this dialog
box reappears. 

Cancel
Choose this option to abort the entire import operation.

See also

Add to Album command 





Messages

This section contains a complete list of the error messages you may receive while working in 
PowerAlbum. The error messages are listed by number. If you need additional support, you can contact 
our Technical Support department. Make a note of the error message number before you call. See 
"Calling Technical Support" in the Introduction to your manual for details. 

500 Picture <> already exists . . . 
510 Common Open dialog . . . 
515 Album <> exists . . . 
520 Album <> has changed . . . 
525 Picture <> already exists . . . 
530 Picture <> cannot be located . . . 
535 Unable to save album . . . 
540 <> is not a valid album file. 
545 Sorry, <> is no longer . . . 
550 Unable to open <> . . . 
555 You must be running . . . 
560 Insufficient memory . . . 
565 You are low on memory . . . 
570 Insufficient memory . . . 
575 Sorry, you must close . . . 
580 Sorry, because you . . . 
585 Unable to initialize . . . 
587 Unable to save, album may be read only...
590 Picture <> does not . . . 
592 You are too low on memory to add more pictures...
594 The category name is already in use...
595 Picture<> already exists . . . 
596 Critical Error! PowerAlbum cannot write...
605 Sorry, not enough memory . . . 
610 Out of disk space 
620 File <> not found
625 File <> not recognized 
630 Unable to load <> filter 
635 Unable to load <> library 
645 Unable to import <> . . . 
647 Unable to print <>...
650 Show Pict was unable to succeed
655 The multimedia file format is not recognized
660 Not enough memory to acces this multimedia file
665 Sorry, unable to read this multimedia file
670 Sorry, unable to open the multimedia file
675 PowerAlbum was unable to add the video file...
680 Your multimedia driver is too old
681 Unable to access the library
682 Disk read error
683 Can't reate file
684 File corrupt
685 An error has oiccurred accessing the multimedia file
686 Failure loading memory manager
690 No export file filter found...
691 Sorry, unable to carry out requested export
692 Requested export not supported
700 Unable to access network drive
720 Picture <> was not found and will not be copied...



730 You are very low on memory...
740 Sorry, this picture type is not currently supported



500 Picture <> already exists in the category. It will not be inserted.

The same picture can appear only once in each category. However, you can put a picture in as many 
different categories and albums as you want.

See also

Messages 



510 Common Open dialog box could not be loaded.

There was a problem with the COMMDLG.DLL file. You may have replaced a newer version of the file 
with an older version. Run SETUP and reinstall PowerAlbum.

See also

Messages 



515 Album <> exists, do you want to overwrite it?

You have specified a filename that already exists. If you choose Yes, you will overwrite that album with 
the currently open album.

See also

Save As command 
Messages 



520 Album <> has changed. Do you want to save it?

You have made changes to the currently open album. Choose Yes to save the changes or No to discard 
them.

See also

Save As command 
Messages 



525 Picture <> already exists in the category. It will not be inserted.

The same picture can appear only once in each category. However, you can put a picture in as many 
different categories and albums as you want.

See also

Adding pictures 
Messages 



530 Picture <> cannot be located. What would you like to do?

The thumbnail picture you selected points to a picture file that is not located in the indicated directory. The
file may have been moved or deleted. 

To correct the error:

1. Choose Search to look for the file in all directories on the indicated drive.

2. If PowerAlbum does not find the picture, try searching a different drive by selecting it from the list 
box. Be aware that this can take time if the indicated drive is large.

3. If Search doesn't work, choose Cancel. You can then either add the picture to your album again, or 
you can delete the thumbnail.

If PowerAlbum locates the picture file, it will remember the new location for the duration of your working 
session (that is, until you close PowerAlbum). If you want PowerAlbum to remember the new location 
permanently, you must save the album. 

Attention network users: If you are sharing an album or clip art files with other users over a 
network, do not save an album if this situation occurs. Read "Principles of network use" in Chapter 
5 of your user's manual for more information. 

See also

Adding pictures 
Removing pictures from a category to delete a thumbnail
Save command 
Messages 



535 Unable to save album file <>. Check disk space.

Don't close the album file. There was an error attempting to save the album file to the indicated path. This 
could be due to insufficient disk space or, the target disk may be read-only. 

To correct the error:

1. Without closing the album file, use the File Manager or similar program to free more space on the 
drive and then try to save the album again. 

2. If this doesn't work, check to see if the drive you are saving to is read-only. If so, try saving to 
another drive using the Save As command.

See also

Save As command 
Messages 



540, 545, 550 PowerAlbum is unable to open <>.

Messages 540, 545, and 550 indicate that PowerAlbum cannot open the album file you specified. 

To correct the error:

1. Make sure the album's filename extension is .ALB. 

2. Check (use File Manager if necessary) to make sure the file is in the directory you think it is. 

If PowerAlbum still can't read the file, it contains errors or is not an album file. This problem may indicate 
that you sometimes run with very low memory. 

See also

Messages 



555 You must be running Windows in Standard or Enhanced mode to start 
PowerAlbum.

To run PowerAlbum, you must be running Windows in Standard or Enhanced mode, not Real mode. 
Consult your Windows manual for more information.

See also

Messages 



560, 565, 570 Insufficient memory to run PowerAlbum.

Messages 560 to 570 indicate that Windows is running out of System Resources (such as memory or 
hard disk space). 

To correct the error:

1. Save the open album if you have made changes, then close PowerAlbum and Windows. 

2. Restart Windows and PowerAlbum and start working again without opening any other applications. 

If you continue to have problems, check the contents of your startup group (the program group that 
contains the PowerAlbum icon). Move icons out of this group to conserve additional memory, then restart 
Windows.

If you have continuing problems that appear to be memory-related, you may have to revise your system 
configuration. 

See also

Save command 
Messages 



575, 580 Running two versions of PowerAlbum.

Messages 575 and 580 indicate that you are trying to run two versions of PowerAlbum at the same time. 
A version of PowerAlbum is included with Calendar Creator Plus. You cannot run Calendar Creator Plus 
and an independent version of PowerAlbum at the same time. 

See also

Messages 



585 Unable to initialize String Dictionary, you may be too low on memory.

Windows is probably running out of System Resources (such as memory or hard disk space). 

To correct the error:

1. Save the album you are working with if you have made any changes to it, and close PowerAlbum 
and Windows. 

2. Restart Windows and PowerAlbum. Don't open any other applications. 

If you have continuing problems that appear to be memory-related, you may have to revise your system 
configuration. 

See also

Saving an album 
Messages 



590 Picture <> does not have the same date as the thumbnail. The 
thumbnail will be updated.

PowerAlbum stores the file creation date of each picture file with the thumbnail image that appears in the 
album. When you display, cut, or copy a picture, PowerAlbum checks a thumbnail image's date against 
the date of the picture file. If the picture file has changed since you added the image to PowerAlbum, the 
new version of the picture file is read and the thumbnail is updated.

See also

Display command 
Cut command 
Copy Picture command 
Messages 



595 Picture <> already exists in the category. It will not be inserted.

The same picture can appear only once in each category. However, you can put a picture in as many 
different categories and albums as you want.

See also

Adding pictures 
Messages 



605 Sorry, not enough memory or file is too large to import.

The picture file may be too large to import, or Windows may be running out memory. 

To correct the error:

1. Save the album you are working with if you have made any changes to it, then close PowerAlbum 
and Windows. 

2. Restart Windows and PowerAlbum. Don't open any other applications. 

If you continue to have problems, check the contents of your startup group (the program group that 
contains the PowerAlbum icon). Move icons out of this group to conserve additional memory, then restart 
Windows.

If the picture is complex, you can try to simplify it in the application where you created it. If you have 
continuing problems that appear to be memory-related, you may have to revise your system 
configuration. 

See also

Messages 



610 Out of disk space.

Use the File Manager or similar program to free more space on the drive. Or use PowerAlbum to check 
your clip art and delete images that you won't ever use.

See also

Deleting pictures from your disk 
Messages 



625 File <> not recognized.

PowerAlbum doesn't recognize this picture file's graphic format. PowerAlbum supports the AVI, BMP, 
CGM, DRW, GIF, JPG, PCD, PCX, TIFF, WAV, WPG, and WMF file formats. If your picture is one of 
these, make sure that it has the correct filename extension for its format. 

See also

Messages 



630, 635 Unable to load <> filter/library.

Messages 630 and 635 indicate that PowerAlbum is trying to load a picture but can't find necessary 
internal data. Run SETUP again and reload PowerAlbum.

See also

Messages 



645 Unable to import <>.
647 Unable to print <>. The file may not exist, or there may not be enough 
disk space or memory.

Messages 645 and 647 may appear if you have a memory problem or if the application that created your 
picture file saved it in an unusual variation of a standard graphics file format. 

See also

Messages 



587    Unable to save, album may be marked read-only.

The album or directory is marked as read-only.    Use File | Save As to save the album with a new name or
to another location.

See also

Messages 



592    You are too low on memory to add more pictures. Close one or more 
Windows applications and try again.

Close one or more windows applications before trying to add more pictures.    You can also minimize and 
then maximize PowerAlbum to force it to free some resources. If this doesnt work, save your work, exit 
PowerAlbum and Windows, restart and try again. See your Windows documentation for tips on optimizing
Windows.

See also

Messages 



594    The category name is already in use.

There is an existing category with this name.    Either select a new name or delete the old category.

See also

Messages



596    Critical Error!    PowerAlbum cannot write to a temporary file or is out 
of memory.    Close PowerAlbum and free some disk space."

The disk designated for storing temporary files is full.    You need to free some disk space on this drive 
and attempt the operation again.    To determine the path of your temporary drive, Type SET at the DOS 
prompt and look for TEMP or TMP. 

See also

Messages



620    File <> not found.

The file may have been deleted or moved. Restore the file to its original location.

See also

Messages



650    ShowPict was unable to succeed

Save your album, exit and restart PowerAlbum.

See also

Messages



655    The multimedia file format is not recognized

PowerAlbum does not support this multimedia file format.

See also

Messages



660    Not enough memory to access this multimedia file

There is not enough memory to access this file.    Close one or more Windows applications and try again.

See also

Messages



665    Sorry, unable to read this multimedia file
670    Sorry, unable to open the multimedia file
685    An error has occurred accessing the multimedia file

The file or disk may be damaged or corrupted.    Check your hard disk using a disk error utility such as 
DOS ScanDisk.

See also

Messages



675    PowerAlbum was unable to add the video file because of a missing 
entry in the registration database.    Please run your video driver setup 
program.

The REG.INI file is missing necessary information for importing your multimedia file.    Reinstall your video
drivers; if this does not help, reinstall PowerAlbum.

See also

Messages



680    Your multimedia driver is too old

MCI multimedia drivers must be compatible with Microsoft Video for Windows version 1.1.

See also

Messages



681    Unable to access the library.

A file necessary to import or export a picture is missing or damaged. Reinstall PowerAlbum to replace the 
file.

See also

Messages



682    Disk read error.

PowerAlbum had trouble reading the disk; the disk may be damaged. You can try using a disk recovery 
utility to recover the data on the disk.

See also

Messages



683    Cant create file.

PowerAlbum couldnt create the new file. Check to make sure you have enough disk space available on 
the disk where you tried to save the file. Try freeing up disk space, closing down other applications that 
you are running at the same time as PowerAlbum, and try again.

See also

Messages



684    File corrupt.

The graphic file is either damaged or is in a format not recognized by PowerAlbum.

See also

Messages



686    Failure loading memory manager.

PowerAlbum was not able to load its memory management program. Reinstall the program and try again.

See also

Messages



690    No export filter found. Please run setup.

The files necessary to export the picture in the format requested are missing or damaged. Reinstall 
PowerAlbum to restore the files.

See also

Messages



691    Sorry, unable to carry out requested export.

PowerAlbum wasnt able to export the graphic file due to lack of disk space or a memory shortage. Try 
freeing up hard disk and closing down other applications you are running at the same time as 
PowerAlbum, then try again.

See also

Messages



692    Requested export not supported.

You cannot currently export this type of graphic file to the file type you requested. For example, you can 
only convert bitmapped graphics, such as BMP files, to other bitmapped formats, such as PCX files. See 
your PFS:PowerAlbum Users Guide for an explanation of graphic file formats.

See also

Messages



700    Unable to access network drive 

PowerAlbum was not able to access a picture file which resides on a network drive.    Check your network 
setup.

See also

Messages



720    Picture <> was not found and will not be copied to the clipboard

The file may have been deleted or moved. Either restore it to its original location, add to the album from 
its new location, or delete the thumbnail.

See also

Messages



730    You are very low on memory.    Some thumbnails may not be 
displayed because there is not enough memory to display them.    Close 
one or more Windows applications in order to free some memory.

You can also try minimizing PowerAlbum to free up some more resources. See your Windows 
documentation for tips on optimizing Windows to free up memory.

See also

Messages



740    Sorry, this picture type is not currently supported

The picture type you have selected to copy to your application is not supported.    For example, your 
application may display picture files but not sound or video files.

See also

Messages




